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Chapter 1: Welcome to Sage 100 Contractor
Installation
Welcome to Sage 100 Contractor installation. Sage 100 Contractor can run inmany different software and network
environments. Because of that, there are issues that you need to take into consideration for each one. Themore information
you can gain about the installation process and how it relates to your software and network environment, themore likely
your installation will proceed smoothly.

To gain an understanding of what’s new about product installation:

o Review the information in this book

o Review theGetting Started insert in the CD envelope

o Read the letter from your business partner.

o Learn about the licensing process. Your Sage 100 Contractor license is managed by the License Administration
program and the Sage license server.

Conventions Used in this Document
This document uses the following conventions:

l The names of screens, windows, fields, and other features displayed by the software are shown in bold type.

l Information you enter into the software is in bold type, as in the following example:
EnterMiscellaneous in theAmount Type box.

l Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates
that you should press both keys at the same time; for example, SHIFT + TAB.

l The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and [Post].

TIP: Helpful information tomake your experience better.

NOTE: This symbol draws your attention to information of particular interest, such as information not included in
steps.

CAUTION: This symbol draws your attention to information that is important because it can help you avoid a costly
or time-consuming error.

IMPORTANT: This symbol draws your attention to information that is of critical importance.

What information is in this book?
The rest of Chapter 1, “Welcome to Sage 100 Contractor Installation,” provides more information about customer
resources, such as:
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o Other printed and printable guides

o The user-assistance Help system

o Contacts for Customer Support

o Sage 100 Contractor training

o Information about business partners.

Chapter 2, “System Requirements and Configuration,” presents technical information about:

o System requirements for servers and client workstations

o Supported operating systems

o Special configurations for specific operating systems

Be sure your computers meet the system requirements before you install the software, as Sage 100 Contractor will not run
correctly or at all on computers that do not meet theminimum requirements.

Chapter 3, “Sage 100 Contractor Installation,” provides detailed information and instructions for installing Sage 100
Contractor software in different environments, such as:

o Single user

o Peer-to-peer

o Network

Chapter 4, “Managing Your License with License Administration,” provides detailed information about:

o Managing and activating your license

o Using License Administration

Chapter 5, “License Use and Sage 100 Contractor,” provides all the necessary details about:

o Specifying the Sage license server

o Managing license attributes

o Understanding license uses

Chapter 6, “Special Configurations,” contains information about special configurations for specific operating systems, such
as:

o Windows® 7 Professional andWindows Server 2008® R2 Standard

o Windows Vista® andWindows Server 2008

o Windows Server 2003®

o Windows XP® Professional

o Citrix® and Terminal Servers
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Customer Support and Resources

Before you contact Customer Support
Before you decide to contact the customer support call center, there aremany resources available to you. Our in-product
help system offers a comprehensive library of easy-to-find topics. Depending on your Sage service plan, we also offer a
web-based Sage Knowledgebase and online user community forums. These services are available 24 hours a day, seven
days a week. Please see below for detailed information about all the resources available to you.

Sage 100 Contractor Help
You can access help about specific procedures, topics, fields, or buttons from anywhere in the software.

Sage Knowledgebase
Our staff maintains an extensive knowledge database of questions and answers covering everything from frequently asked
questions tomore complex problems and solutions. In addition, we keep all product reference documentation available in
the Knowledgebase. This online tool is the same tool we use in our customer support call center to help answer your call.
Depending on your Sage service plan, you can access this Knowledgebase at www.sagecre.com or through the in-product
Helpmenu.

To access the Technical Support Knowledgebase:
1 Click www.sagecre.com/customerlogon.

2 On theWelcome page, in the left column, click Knowledgebase Search to open a list of products.

3 CompleteStep 1 by selecting Sage 100 Contractor from the list of products.

4 CompleteStep 2 by entering a search term in the box.

5 Click Search. The search results appear below the box.

Sage 100 Contractor InfoCenter
Find all the information you need about Sage 100 Contractor software notices, industry news, products, services, new
enhancements, tips, training, special offers andmore.

http://www.na.sage.com/sage-100-contractor/infocenter-news

Technical Documentation Available on the Software CDs
A number of guides are included on the software CDs we ship to you. Access important release information such as
system requirements, software enhancements, quickly and easily.

Sage Summit Customer Conference
Interact with and learn from Sage Construction and Real Estate senior leadership, product experts, and fellow customers in
one location. Get the latest information on product updates as well as network and share experiences with your peers.
Check our website for current conference information.

http://www.sagecre.com/
http://www.sagecre.com/customerlogon
http://www.sagemasterbuilder.com/lp/InfoCenter-News
http://www.sagemasterbuilder.com/lp/InfoCenter-News
http://www.sagemasterbuilder.com/lp/InfoCenter-News
http://www.sagemasterbuilder.com/lp/InfoCenter-News
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Prepare to contact Customer Support
Depending on your Sage service plan, youmay be able to contact the Sage Customer Support Call Center to work with one
of our highly trained customer support professionals. Before you call, here is a quick reference list of questions wewill often
ask to help resolve your question. Prepare your answers to these questions before calling Sage Customer Support to save
you time when calling us.

Question How to Find the Answer

What is your Sage client
ID number?

Your client ID number can be found on correspondence you receive from Sage. If you do
not know your Sage client ID, please contact the person at your company whomaintains
your relationship with Sage.

What CD version are you
using?

To find the version, open Sage 100 Contractor; clickHelp > About Sage 100 Con-
tractor and note the number listed.

What application or area
in the software are you
calling about?

On themenu list, identify the application and number where are you are work (i.e.
Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).

How can we help you? Walk through the exact steps you completed with asmuch detail and accuracy as
possible.

Is there an error mes-
sage? Write down the exact wording of themessage.

Can you reproduce the
issue?

Were you able to walk through the same steps that led to the problem and see
whether it happened again?

Is this the first time the
problem has happened?
Does the problem occur
on one workstation or sev-
eral?

Ask other users if they have experienced the same problem. Have them test at their
workstation to see if they experience the same problem. Also, have the original
user try other workstations to see whether the problem is specific to that user.

Has anything changed
with your software, hard-
ware, or workflow?

Ask your network administrator for technical information regarding anything that
may have changed behind the scenes: upgrades to Sage 100 Contractor, new
third-party software installations, moving of data from one server to another, new
printers or print driver installation, or anything else that might affect the network.

Does the problem
happen in the sample
data sets?

Select [File> Open Company], then change the drive letter on the dropdown to
C:, select Sample Company.

What kind of network are
you using? If you do not know, please contact your network administrator.

What operating system is
on your computer?

For XP: Click [Start], click [Run], type winver and click [OK].

For Vista: Click [Start], type winver in the ‘start search’ window and click [OK].

What printers and print
drivers are installed? If you do not know, please contact your network administrator.

When was your last
backup? If you do not know, please contact your network administrator.
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Customer Support Call Responses
Our goal is to answer all calls within the first threeminutes, but more often than not we answer your call on the first ring!
Once calls are answered, our support analysts resolve over 90% of questions during the first contact. They work with you
to identify call urgency and respond accordingly. Call urgencies range from a simple explanation of software settings to
critical situations in which work is stopped or data integrity is compromised. The support analyst will work with you based
on the urgency to take the appropriate action, if a call is unable to be resolved immediately. Some calls may warrant further
research and followup, in which case our support analyst will place your call in his/her in-progress work list. At every step of
the way, we work with you to until a resolution or agreement can be reached.

Depending on your Sage Service plan, if you have an open support ticket, youmay check the status or update, or even
create a new support ticket online. Just visit www.sagecre.com and click the [Customer Support] button. Logon to the
Sage Customer Portal. Next, select the Support tab and choose the [Self Service] button.

Youmay check the status of an open support ticket, update new information you’ve discovered on an open issue, or create
a non-urgent request for help online. Just visit www.sagecre.com and click the [Customer Support] button. Logon to the
Sage Customer Portal. Next, select the Support tab and choose the [Self Service] button.

Contact Customer Support
Contact Customer Support in the United States and Canada at: www.sagecre.com

Sage 100 Contractor toll free: 800-866-8049

International: 503-690-6775

Customer Support Hours
Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Timewith the exceptions listed below.
Online support incidents can be submitted 24 hours a day, seven days a week by logging on to
www.sagecre.com/customerlogon. Our customer support team will reply to your questions during normal support hours.

o Every Thursday from 2 p.m. to 3 p.m. Pacific Time, closed for staff meetings.

o Standard United States holidays.

o Quarterly company meetings.

Any additional closures will be communicated by our regular customer email newsletters.

Training Resources
Whether you choose to take online classes from Sage, participate in classroom training, or work directly with your business
partner, you will learn how to use Sage 100 Contractor to support your business. Contact your business partner to find out
about training options or visit www.sageu.com/sage100contractor.

Overview of customer classes
Online classes helpmake learning Sage 100 Contractor convenient. Each instructor has years of experience using Sage
100 Contractor and will lead you step-by-step through the class material.

Online classes allow you to view the instructor’s computer screen as he or she demonstrates Sage 100 Contractor
software. Once you register for your class via Sage University, you will receive email communications that tell you how to
access the training. Because the classes are live, you can ask questions and benefit from hearing other students’

http://www.sagecre.com/
http://www.sagecre.com/
http://www.sagecre.com/
http://www.sagecre.com/customerlogon
http://www.sageu.com/sage100contractor
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questions. Classes cover all aspects of Sage 100 Contractor, including project management, estimating, scheduling, and
payroll. For more information, visit www.sageu.com/sage100contractor.

Getting started with training
All customers should begin with our New Customer Training (NCT) series, which is included in our Essentials Training
Package in recorded format for 24/7 access. These classes include an overview of the Sage 100 Contractor system and its
features. Customers that prefer live online training can register for the Realtime Learning version of these NCT courses. For
more information, visit www.sageu.com/sage100contractor.

Business Partners
To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of
business partners.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation,
implementation, and training. They're fully equipped to help you get where you want to be. For more information, please
contact your Sage 100 Contractor business partner.

Business Forms
Sage 100 Contractor is designed to work with generic checks and forms that are available frommany sources. There is no
single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and checks through
Sage Construction and Real Estate Forms by calling 800-760-7929 or by visiting www.sagecreforms.biz.

Chapter 2: System Requirements and
Configuration
This section provides information about system requirements along with general and specific configuration options.

Internet Access Required for Sage 100 Contractor
Sage 100 Contractor features such as printing or efilingW-2s or 1099s, submitting enhancement requests, or downloading
periodic product or tax updates all require Internet access. To take advantage of these features, please ensure any
workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the
Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage
100 Contractor is installed, then disconnect the Sage license server from the Internet.

Hardware Requirements

Server hardware specifications
We cannot recommend server hardware specifications for your network, as this depends on your specific requirements,
such as the number of users on your network, or other programs that might use server resources, such as firewalls,
software applications, mail systems, and so forth. We can, however, recommend a set of minimum hardware
requirements.

Server hardware requirements
The following table shows the operating systems that are supported for the server computers running Sage 100 Contractor.

http://www.sageu.com/sage100contractor
http://www.sageu.com/sage100contractor
http://www.sagecreforms.biz/
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NOTE: Theminimum processor requirements for servers listed in the table below are based on theMicrosoft®
Windows® Server 2003® operating system family. When updating or purchasing servers running newer operating
systems such as Windows Server 2008®, Small Business Server® 2008, and Server 2008 R2 Standard, we
recommend that you also refer to Microsoft system requirements.

Hardware Minimum Recommended

Processor Intel® Pentium® 4 or comparable Intel®Dual Core/Quad Core™ or comparable, 2 GHz+

RAM 2GB 4GB+

Free Disk Space 3.5 GB 3.5 GB+

CD-ROMDrive 2X CD-ROM 24X CD-ROM+

Printers For highest quality printing, we recommend laser or inkjet printers.

IMPORTANT: Theseminimum recommendations include 370MB of hard disk drive space required for running
Microsoft .NET Framework 3.5 Service Pack 1 software.

Client and workstation hardware requirements
The following table shows the hardware requirements for client and workstation computers running Sage 100 Contractor.

Hardware Minimum Recommended

Processor (except Vista/Windows 7) Pentium 4 or comparable Intel Dual Core or comparable

Vista/Windows 7 processor 1 GHz 2GHz+

RAM (except Vista/Windows 7) 1GB 2GB+

Vista/Windows 7 workstation RAM 2GB 4GB+

Free Disk Space 1GB 3GB+

CD-ROMDrive 2X CD-ROM 2X CD-ROM+

Printers For highest quality printing, we recommend laser or inkjet printers.

NOTE: Theseminimum recommendations include the 230MB required for runningMicrosoft .NET Framework 3.5
Service Pack 1 software on client workstations. The recommended free disk space is based on the installation of a
single program and the average size of a Sage 100 Contractor company database. Allow at least 50MB for each
additional company database that you create.

Sage 100 Contractor now supports virtual server environments
In addition to the performance and cost savings benefits to our customers, virtualization is expected to be a commonly
used technology going forward. We have begun a review and evaluation of virtual environments with Sage 100 Contractor
and are prepared to field technical support questions related to running Sage 100 Contractor v17 in a virtual environment.
Business partners are expected to configure and support the virtualization itself. For more information, please contact your
Sage 100 Contractor business partner.
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Operating Systems Requirements

Operating systems
We recommend that the following issues be taken into account for a smooth and successful installation experience.

Supported Operating Systems

Server, 32 and 64-bit Operating Systems Client/Workstation, 32 and 64-bit Operating
Systems

Microsoft Windows Server 2008®R2Standard Microsoft Windows 7 Professional

Microsoft Small Business
Server 2008® Microsoft Windows Vista Business

Microsoft Windows Server 2008 Microsoft Windows XP® Professional (SP 2 or newer)

Microsoft Windows Server 2003®

Microsoft Windows Small Business Server 2003® (SP 1 or
newer)

Unsupported Operating Systems

NOTE: Sage 100 Contractor and/or its components do not run on or do not support some operating systems. Do not
install Sage 100 Contractor to computers running theseMicrosoft Windows operating systems:

o Microsoft Windows 95®
o Microsoft Windows 98®
o Microsoft Windows NT® Server
o Microsoft Windows NTWorkstation

o Microsoft Windows 2000®
o Microsoft Windows 2000 Server®
o Microsoft Windows XP Home ®
o Microsoft Windows Vista Home Basic

o Microsoft Windows Vista Home Premium

IMPORTANT: Microsoft .NET Framework 3.5 Service Pack 1must be installed to all computers running Sage 100
Contractor and the License Administration Tool. During installation, Microsoft .NET Framework 3.5 Service Pack 1 is
installed on your computer automatically if it is not already installed. Be sure that all server and client computers meet
both .NET Framework requirements and Sage 100 Contractor requirements.

NOTE: When you have a network with three or more users, a dedicated file server increases performance and
reliability.

Web browser requirements
Web browser requirements and recommendations are:



- 9 -

Minimum

Microsoft Internet Explorer® 6.0, Service Pack 1 or later

Supported Microsoft Office versions
The following table shows which versions of Microsoft Office are supported in Sage 100 Contractor.

Supported Microsoft Office Versions

Microsoft Office 2003

Microsoft Office 2007

Microsoft Office 2010

Network Configuration Requirements

Server network configuration requirements
The following table shows the server network configuration requirements for server computers running Sage 100
Contractor.

IMPORTANT: Youmust allow HTTPS outgoing traffic on port 443 to the outside Internet. This is a requirement of the
licensing and entitlement service.

Process Required

Network Protocol TCP/IP

Minimum Network Speed - LAN 10/100/1000Mbps

Minimum Network Speed -WAN +/- 1.5Mbps receiving data (downstream)
+/- 384 Kbps sending data (upstream)

NOTE: Sage 100 Contractor typically runs in a local area network (LAN) environment. Sage 100 Contractor can run in
a wide area network (WAN) using Citrix or Terminal Services. Contact your business partner for more information.

Client and workstation network configuration
The following table shows the server network configuration requirements for client and workstation computers running Sage
100 Contractor.

IMPORTANT: The Sage 100 Contractor Hosting Framework servicemust be unblocked from accessing incoming
connections. This is done automatically when using theWindows Firewall, but other firewalls running on the server
may require additional configuration.

Process Required

Network Protocol TCP/IP

Minimum Network Speed - LAN 10/100/1000Mbps

Minimum Network Speed -WAN 128 Kbps Broadband
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NOTE: For information about running Sage 100 Contractor in a wide area network (WAN) using Citrix and Terminal
Services, contact your business partner.

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations
can potentially disable the communication:

l File sharing on computers running theWindows 7, Vista, Server 2008, and Server 2008 R2 operating systemmust
be enabled. To enable file sharing, follow the instructions in theWindows 7/Vista/Server 2008 Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on the local
computer.

l Software firewalls running on the local computer can be configured to block processes from opening TCP ports,
which will prevent communication through the TCP Remoting Channel.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured automatically to
allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you
may need tomanually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100 Contractor
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party
firewall products.

To configure the Windows Firewall:
1 Click Start > Control Panel > Security Center (XP) orSecurity (Vista/Server 2008) orSystem and Security
(Windows 7).

2 OpenWindows Firewall, and select theExceptions tab (XP) orAllow a program or feature through Windows
Firewall (Vista, Windows 7, and Server 2008).

3 If Sage 100 Contractor Hosting Framework is not on the list, then you can add it by selectingAdd Program, then
browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. If desired, you can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can cause the
computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows XP Professional and Windows
Server 2003

l C:\MB7

l C:\Documents and Settings\All Users\Application Data\Aatrix Software

l C:\Program Files\Aatrix Software

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit
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l C:\MB7

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit

l C:\MB7

l C:\ProgramData\Aatrix Software

l C:\Program Files (x86)\Aatrix Software

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 32-bit

l C:\MB7

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 64-bit

l C:\MB7

l C:\ProgramData\Aatrix Software

l C:\Program Files (x86)\Aatrix Software

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008 32-bit

l C:\MB7

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008 R2

l C:\MB7

l C:\ProgramData\Aatrix Software

l C:\Program Files (x86)\Aatrix Software

l Network location of Sage 100 Contractor data
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Microsoft .NET Framework 3.5 Service Pack 1 Requirements

About installation and Microsoft .NET Framework
When you install Sage 100 Contractor software, you will also install theMicrosoft .NET Framework 3.5 Service Pack 1, if it
is not already installed. It is important that youmake sure that both your client and server computers meet theminimum
requirements for installing both Sage 100 Contractor software andMicrosoft .NET Framework 3.5 Service Pack 1.

IMPORTANT: If the Sage 100 Contractor installation requires an installation of Microsoft .NET Framework 3.5
Service Pack 1, the Sage 100 Contractor installation process may continue automatically after the .NET Framework
installation is completed. If you are prompted to restart your computer after the .NET Framework installation,
however, youmust do it to continue the Sage 100 Contractor installation.

About installing .NET Framework 3.5 Service Pack 1 and Operating Systems

NOTE: If Microsoft .NET Framework 3.5 Service Pack 1 is not already installed on your computers, then that
installation alonemay take up to 20minutes per computer.

The following are the supported operating systems for .NET Framework 3.5 Service Pack 1:

o Windows 7 Professional

o Windows Server 2008 R2 Standard

o Windows Vista Business

o Windows Server 2008

o Windows Server 2003

o Windows XP Professional

Viewing and verifying system information
Youmay use the winmsd.exe to open theSystem Informationwindow to view a list of your system information. The
winmsd.exe program is not available with theWindows Vista Business operating system.

To view and verify system information:
1 Click [Start], the click [Run].

2 The [Run] dialog box opens.

3 In the [Open] text box, type winmsd.exe, and then press the Enter key.

TheSystem Information window opens displaying a list of your system information.

.NET Framework Requirements for Server Computers
Minimum requirements for Microsoft .NET Framework Service Pack 1 on servers

Component Required

Hard disk space at installation 800MB

Hard disk space to run 370MB

Video card 800x600, 256 colors
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.NET Requirements for Client Computers
Minimum requirements for the Microsoft .NET Framework 3.5 Service Pack 1 on clients

Component Required

Hard disk space at installation 160MB

Hard disk space to run 70MB

Video card 800x600, 256 colors

Report Scheduling and Faxing Functionality

About setting up emailing and faxing through Sage 100 Contractor
Using the faxing functionality through the Sage 100 Contractor program requires:

o Installation of theWindows operating system Fax Service component

o A separate installation and setup of a fax modem in your workstation

o Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that camewith your fax
modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing theWindow operating system Fax Service component, see Installing theWindow Fax
Services component.

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing fromWindows. To fax from Sage 100 Contractor, you should download and install the latest
version from http://get.adobe.com/reader/.

Disengage automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disengage the automatic “check for
updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

NOTE: Instructions disengaging automatic “check for updates” differ from version to version of Adobe Reader. Refer
to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple
mail transfer protocol (SMTP) email server.

TheEmail Settingswindow provides a way for you to set up email. You can change the selections to accommodate
different emailing preferences.

You can access theEmail Settingswindow through:

http://get.adobe.com/reader/
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n Any Report Printingwindow by clicking theEmail button on the toolbar to open theEmail Distributionwindows.
Then, click theEmail Settings button to open theEmail Settingswindow.

n 7-9 Alerts Manager

n Click onSettings in the Dispatch Board, then click onEmail Setup.

Sage 100 Contractor and SMTP

IMPORTANT: The SMTP server may be located on your workstation PC, on a server on your company’s network, or
at your Internet service provider (ISP). If the email server is local, youmay need the assistance of an IT professional
to properly identify or set up this capability. If the email server is located at your ISP, youmay need contact your ISP
for assistance.

Using the ISP’s simplemail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user
authentication” at the STMP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication
means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to
verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

o Sage 100 Contractor user name and password

o Network domain user name and password

o Windows system user name and password.

NOTE: Wedo not provide support for setting up or installing an email server. You set up user authentication and your
fax line access dial out number on 7-2 Company Information.

Installing the Windows Fax Services component
To fax from Sage 100 Contractor, youmust install theWindows Fax Services component.

To install the Window Fax Services component (XP):
1 Open theWindow Control Panel.

2 On theControl Panel window, double-click Add or Remove Programs.

3 On theAdd or Remove Programswindow in the left column, click theAdd/Remove Windows Components icon.

4 On theWindows Components Wizardwindow, select the Fax Services check box, and clear all the other check
boxes.

5 Click Next, and follow the instructions on the screen.

To install the Window Fax Services component (Vista):
1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On theWindows Featureswindow, locate theWindows fax and scan check box, then select it.

3 Click [OK].

To install the Window Fax Services component (Windows 7):
1 Click Start > Control Panel > Programs > Turn Windows features on or off.
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2 On theWindows Featureswindow, locatePrint and Document Services, then click on theWindows fax and scan
check box.

3 Click [OK].

Sage 100 Contractor API

System requirements for Sage 100 Contractor API
If you are using the Sage 100 Contractor API, theminimum and recommended system requirements may vary. These
requirements must be considered in addition to the recommended system requirements for running Sage 100 Contractor.

It may be necessary to increase the processor speed, memory and/or disk space of your system depending upon the
requirements of the third-party application using the API. Please consult with your third-party vendor to determine what
changes, if any, should bemade to your hardware configuration in order to meet your desired performance criteria.
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Chapter 3: Sage 100 Contractor Installation
Pre-installation information for new customers
Implementing and running your business in Sage 100 Contractor must be thoroughly planned out in advance to harness the
power of this software. Your existing company datamust bemigrated before you start working in the program. Your
business partner can assist you with a datamigration and business implementation plan. For more information about
implementing Sage 100 Contractor for your company, see the information about business partners in Chapter 1 of this
guide.

We recommend that you take full advantage of all the knowledge and advice found in Sage 100 Contractor documentation
and training classes. We also recommend that you work with your business partner and accounting professionals before
you begin to implement this software for your business.

IMPORTANT: We recommend that you install the Sage license server on a computer that is always available to
other computers on your network that are running Sage 100 Contractor.

Pre-installation information for existing customers
Because existing customers are working with company information and possibly with scheduled reports, please review
these important points before you start to install the program.

NOTE: Before you install, make at least one backup copy, but consider making two backup copies of your existing
company data for an extra margin of safety.

Duration of the installation process
Plan on at least five and possibly up to 20minutes per computer to install Sage 100 Contractor. The duration of the Sage
100 Contractor installation depends a great deal upon each computer’s configuration. For example, some newer computers
are pre-installed with essential software required to run Sage 100 Contractor software such as the .NET Framework 3.5
Service Pack 1. Installation to older computers may takemore time.

Additional required software
Microsoft .NET Framework 3.5 Service Pack 1must be installed on all computers running Sage 100 Contractor software.
The installer determines if the .NET Framework 3.5 Service Pack 1 is already installed. If not, the installer installs the
required software automatically.

Plan for an additional 10 to 15minutes per computer to install .NET Framework 3.5 Service Pack 1.

NOTE: It is very important that you understand the network environments and operating systems on the computers
and server computers where you install Sage 100 Contractor software. Chapter 6 Special Configurations provides
detailed information about installing to different environments.

About installing the Sage 100 Contractor software to different configurations
You can install Sage 100 Contractor software tomany different configurations, for example, stand-alone, network server,
Citrix and Terminal Services servers, peer-to-peer, and workstations.
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IMPORTANT: The optimal operational size of a peer-to-peer network running Sage 100 Contractor is two to five
workstations. Additional workstations may adversely impact Sage 100 Contractor response times. Networks
consisting of more than five (5) workstations may need to use one computer as a dedicated server.

Sage 100 Contractor allows users to share data and reports stored on a network hard drive. From different workstations,
users can then access the server to share one set of data, one set of reports, and one set of report forms.

During installation, the installer checks for the components necessary to run Sage 100 Contractor and then copies the
programmodules and reports to the \MB7 folder and subfolders that are created on the hard disk. In addition, the installation
process copies system files necessary for program operations to theWindows andWindows System folders.

The installation process does not make any configuration changes to the computer. After installation is complete, youmust
configure the stand-alone computer, server computer, or workstation for optimal performance. For example, you need to
configure the date format on computers running theWindows Server 2003 operating system. For detailed information about
configuring each server and workstation depending on its operating system, see Chapter 6, Special Configurations.

Connectivity across your network
For client workstations to be able to run Sage 100 Contractor, they must all be connected to the Sage license server. If one
user sees the “Sage 100 Contractor can’t communicate with the designated Sage license server” message when all other
people are connected, then you know that the connectivity problem is limited to that one person. If you encounter a
hardware failure with your license server, then no one will be able to run Sage 100 Contractor.

Option to update reports and report forms on a shared drive during an upgrade
installation
If you are running Sage 100 Contractor in a network environment, this option enables you to update shared system reports
and report forms located on a network drive during an upgrade installation. When you select this option, the installation
process enables a list of network drives that already have an \MB7 folder.

IMPORTANT: This option only updates system reports and report form files. It does not perform a complete
installation. If you need to be able to runSage 100 Contractor on the targeted server or the server’s licensing needs to
be updated, youmust do a complete installation directly on the server.

Installing the Sample Company
The Sample Company provides themeans for viewing and working with sample data in Sage 100 Contractor windows.
There are sample accounts, sample employees, sample takeoffs, andmuchmore. By viewing and working with this
sample data, you can gain an understanding of how different windows interact with the sample data whenmanaging a
construction business with Sage 100 Contractor.

Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor training classes.
We highly recommend that you load the Sample Company during your initial installation.

You can log on to the Sample Company using “Supervisor” as the user name. You do not need a password.

The Sample Company:

o Allows you a safe way to try out new functions as you learn them.

o Is used inmany online and recorded classes.

o Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to understandmany
concepts.
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o Provides starter lists for many values you'll need to set up: cost codes, cost types, tasks, client status, client type,
employee positions, paygroups, etc.

o Provides you with live data to investigate the content of Sage 100 Contractor reports.

o Takes very little space on your hard disk drive.

Installing the Sample Company overwrites any previous installations of the Sample Company. If you havemade changes
in your Sample Company that you wish to keep, rename this folder before installing a fresh copy of the Sample Company.

New Installations
A new installation is defined as installing the software on a computer that has never had Sage 100 Contractor installed on it
before.

NOTE: Instructions for reinstallation/upgrade installation over an existing installation are different. See Upgrade Pre-
installation.

Youmust designate one computer on your network as the Sage license server. This server will manage use of Sage 100
Contractor; for example, the number of people who can use Sage 100 Contractor simultaneously on your network. You will
need to install the software on this computer first and then activate your licenses before installing Sage 100 Contractor on
your other computers.

The installation package of files is the samewhether it is available to you on a CD or in a folder on a network drive.

There are two ways to install the program:
o You can install Sage 100 Contractor from the product CD at each computer.

o You can copy the entire CD (all files and folder) to a folder that you create on a network drive and then install to each
client workstation by launching the installation from that network folder from that client workstation.

Nomatter which installationmethod you use, we recommend that you install to the Sage license server computer first.
Then when you install the program to your workstations, you can set up Sage 100 Contractor to find the Sage license server
and run the program using your license.

The installation process also presents different installation windows depending on whether you are installing Sage 100
Contractor as the Sage license server or you are just installing Sage 100 Contractor by itself.

Basic steps for new installations are:
1 First install the program on your network server, the computer where all your company data is located. You do this only
once on your network. Remember to write down the Sage license server computer’s IP Address and/or computer name,
which is displayed at the end of the installation.

2 Next, activate your licenses.

3 Install the program to all client workstations on your network.

4 From each client workstation, specify the Sage license server.

IMPORTANT: Always start installing the program at the computer that will be your Sage license server, which is
likely to be your network server.

Installing Sage 100 Contractor on the Sage license server
Use these instructions when installing the software on the computer you’ll use as the Sage license server or if you are
running in a stand-alone environment. Stand-alonemeans that you are running Sage 100 Contractor on one computer, or



- 19 -

you are not networking with other computers running Sage 100 Contractor.

Find your installationmethod below, either CD or network folder, and follow the installation instructions.

To install from a CD:
1 Close all open programs except for firewall and antivirus programs.

2 Insert the Sage 100 Contractor CD into your CD-ROM drive.

3 If the install program does not start automatically, go toStart > Run > Browse, locate your CD drive and select
setup.exe. Then click [OK].

4 Read the instructions on the installation welcomewindow, and click [Next]. 

5 On the installation option window, select the option This computer will be my Sage license server, and click [Next].

6 On license agreement window, read the License Agreement carefully.

7 Select the check box to accept the terms, then click [Next] to continue the installation.

8 The select a drive window appears.

IMPORTANT: Sage 100 Contractor should always be installed to a local drive. You can share Sage 100 Contractor
data that is located on a network drive among client workstations that are running Sage 100 Contractor locally.

9 Select a local drive location for the installation, and click [Next].

10 On the select additional options window, select the option Install the Sample Company for training purposes. We
recommend that you install the Sample Company.

11 Click [Next].

NOTE: The installer begins the installation process. It checks to see if the computer has .NET Framework 3.5 Service
Pack 1 installed. If these programs are not found, the installer installs them.

12 At the end of the installation process, a confirmation window appears containing a list of installed programs.

a Sage 100 Contractor

b License Administration for Sage 100 Contractor

NOTE: This window also displays the computer’s IP Address and its network name. You will use this information to
specify the Sage license server.

13 Review the list of installed programs, and write down the IP Address and network name of the computer.

IMPORTANT: Write down and keep the Sage license server computer’s IP Address and name in a convenient
location. To select the Sage license server from client computers running Sage 100 Contractor, you need to select its
name from a list or type the computer’s IP Address or name in a text box.

14 Click [Next].

15 The activate your product licenses window appears. The Launch the License Administration program check box is
pre-selected to launch the License Administration program so you can activate your licenses.

16 Read the instructions about activating your product licenses, and then click Finish, leaving the Launch the License
Administration program check box selected.

To install from a CD image in a network folder:
1 Close all open programs except for firewall and anti-virus programs.

2 On a network drive, create a folder named, for example, Sage 100 Contractor CD Image.
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3 Copy the entire contents of the CD (all files and folders) to that folder.

4 In the folder that you have created, locate the setup.exe file and double-click it.

5 On the installation option window, select the option This computer will be my Sage license server, and click [Next].

6 On license agreement window, read the License Agreement carefully.

7 Select the check box to accept the terms, then click [Next]to continue the installation.

8 The select a drive window appears.

IMPORTANT: Sage 100 Contractor should always be installed to a local drive. You can share Sage 100 Contractor
data that is located on a network drive among client workstations that are running Sage 100 Contractor locally.

9 Select a local drive location for the installation, and click [Next].

10 In the next installation window, you are presented with either one option or two options.

11 On the select additional options window, select the option Install the Sample Company for training purposes. We
recommend that you install the Sample Company.

12 Click [Next].

NOTE: The installer begins the installation process. It checks to see if the computer has .NET Framework 3.5 Service
Pack 1 installed. If this program is not found, the installer installs it.

13 At the end of the installation process, a confirmation window appears containing a list of installed programs.

l Sage 100 Contractor

l License Administration for Sage 100 Contractor

14 This window also displays the computer’s IP Address and its network name. You will use this information to specify the
Sage license server.

15 Review the list of installed programs, and write down the IP Address and network name of the computer.

IMPORTANT: Write down and keep the Sage license server computer’s IP Address and name in a convenient
location. To select the Sage license server from client computers running Sage 100 Contractor, you need to select its
name from a list or type the computer’s IP Address or name in a text box.

16 Click [Next].

17 The activate your product licenses window appears. The Launch the License Administration program check box is
pre-selected to launch the License Administration program so you can activate your licenses.

18 Read the instructions about activating your product licenses, and then click Finish, leaving the Launch the License
Administration program check box selected.

NOTE: For information about this process, press F1 on themain License Administration window.

Installing Sage 100 Contractor on client workstations
Find your installationmethod below, either CD or network folder, and follow the installation instructions.

To install Sage 100 Contractor only from a CD:
1 Close all open programs except for firewall and antivirus programs.

2 Insert the Sage 100 Contractor CD into your CD-ROM drive.

3 If the install program does not start automatically, go toStart > Run > Browse, locate your CD drive and select
setup.exe. Then click [OK].



- 21 -

4 Read the instructions on the installation welcomewindow, and click [Next]. 

5 On the installation option window, select the option This computer will run Sage 100 Contractor only, and click [Next].

6 On the license agreement window, read the License Agreement carefully.

7 Select the check box to accept the terms, then click [Next] to continue the installation.

8 The select a drive window appears.

9 Select a local drive location for the installation, and click [Next].

10 The installer begins the installation process. It checks to see if the computer has .NET Framework 3.5 Service Pack 1
installed. If this program is not found, the installer installs it.

11 On the select additional options window:

a Install the Sample Company for training purposes. We recommend that you install the Sample Company.

b Update reports and report forms on a local or network drive. This does not install the entire Sage 100 Contractor
program on the other drive. It only updates the system reports and report forms.

NOTE: This optionmay not appear for first-time installations because it is unlikely that a shared \MB7 folder already
exists on your network.

The installer begins the installation process. It checks to see if the computer has .NET Framework 3.5 Service Pack 1
installed. If this program is not found, the installer installs it.

If the install program does not start automatically, go toStart > Run > Browse. Locate your CD drive or CD image folder,
select setup.exe, and then click [OK]. If your computer security warns you that Sage Licensing is trying to access the
Internet, click [Allow].

12 An installation complete window appears. The Launch Sage 100 Contractor check box is preselected so that you can
launch Sage 100 Contractor and specify the Sage license server.

13 Read the important message and follow the instructions to launch Sage 100 Contractor.

14 Click [Finish].

15 Sage 100 Contractor begins its launch process by displaying the Specify Sage License Server window.

For more information about this process, you can click the Help button on the Specify Sage License Server, or see Chapter
5 License Use and Sage 100 Contractor.

To install Sage 100 Contractor only from a CD image in a network folder:
1 Close all open programs except for firewall and anti-virus programs.

2 On a network drive, create a folder named, for example, Sage 100 Contractor CD Image.

3 Copy the entire contents of the CD (all files and folders) to that folder.

4 In the folder that you have created, locate the setup.exe file and double-click it.

5 Read the instructions on the installation welcomewindow, and click [Next]. 

6 On the installation option window, select the option This computer will run Sage 100 Contractor only, and click [Next].

7 On the license agreement window, read the License Agreement carefully.

8 Select the check box to accept the terms, then click [Next] to continue the installation.

9 The select a drive window appears.

10 Select a local drive location for the installation, and click [Next].
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11 The installer begins the installation process. It checks to see if the computer has .NET Framework 3.5 Service Pack 1.
If this program is not found, the installer installs it.

12 On the select additional options window:

a Install the Sample Company for training purposes. We recommend that you install the Sample Company.

b Update reports and report forms on a local or network drive. This does not install the entire Sage 100 Contractor
program on the other drive. It only updates the system reports and report forms.

NOTE: If the install program does not start automatically, go to Start > Run > Browse. Locate your CD drive or CD
image folder, select setup.exe, and then click OK. If your computer security warns you that Sage Licensing is trying to
access the Internet, click Allow.

13 An installation complete window appears. The Launch Sage 100 Contractor check box is preselected so that you can
launch Sage 100 Contractor and specify the Sage license server.

14 Read the important message and follow the instructions to launch Sage 100 Contractor.

15 Click [Finish].

16 Sage 100 Contractor begins its launch process by displaying the Specify Sage License Server window.

Upgrade Installations
If you currently have Sage 100 Contractor installed on your network computers and you are going to reinstall it, you could be
either upgrading or updating the software.

Upgrade installations involvemajor changes, enhancements, and fixes tomany parts of the program or tomodules such as
licensing. For example, installing Version 15 over Version 14 is an upgrade installation because there aremajor
enhancements to the program.

Update installations, in contrast, usually involve changes to specific files, such as the Sage.SMB.PayrollTax.dll file and
report forms. These files can be changed and updated without any changes tomajor parts of the program.

In addition, upgrade installations are different from new installations. During new installations (or reinstallation after
completely removing Sage 100 Contractor and Sage licensing), you can designate a computer to be either the Sage license
server or a client workstation.

Upgrade Pre-installation
Upgrading your Sage 100 Contractor software requires that you complete preliminary tasks to ensure the safety of your
company data.

When upgrading, it is important that you choose a block of time when you can install the upgrade to all the computers in
your office beginning with your Sage license server. Depending on your computer’s hardware and your network
configuration, plan on 15minutes per computer for the installation process alone. Additional tasks may take extra time.

The following are steps to take before upgrading Sage 100 Contractor:

1 Make two backups of your company data. We suggest making two backups in case one of them is incomplete, becomes
corrupted, or is lost.

2 Exit Sage 100 Contractor and all other programs - Youmust not install the Sage 100 Contractor upgrade when either
Sage 100 Contractor or the Sage 100 Contractor API are running. We recommend that you shut down all other programs
when installing Sage 100 Contractor, but you do not have to shut down firewall and anti-virus software.

3 Locate the computer on your network that is your Sage license server, and begin the upgrade installation there.
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Upgrade Installation
Always begin all installations at the computer that is the Sage license server. After installing the upgrade to the Sage
license server, install the upgrade to your workstations from the image placed in a folder on the network.

Sage 100 Contractor running on client workstations needs to connect to the Sage license server to access your company
data. If you do not change the designation of any computers on your network during an upgrade installation, all client
workstations will be able to locate the existing Sage license server again after installation.

In addition to installing the Sample Company, youmay have the option to update system reports and report forms on a local
or network drive. For example, let’s suppose that your system reports and report forms are located on a shared driveM
under an existing \MB7 folder. Now during Sage 100 Contractor installation to drive C on your local computer, you can also
update system reports and report forms to shared driveM.

This option is only available if an \MB7 folder already exists on a different local or network drive. Updating system reports
and report forms on different drive does not install the Sage 100 Contractor program. For example, if you want to install
Sage 100 Contractor to a network drive, you have to go to that computer and install the program from there.

NOTE: You only need to update your system reports and report form once on the shared drive from one computer on
your network.

Installing the upgrade
When installing, use the same upgrade installation steps for both your Sage license server and your workstation
computers.

IMPORTANT: Install the upgrade to the existing Sage license server computer first. Install the upgrade to all
workstations only after the license server installation has been completed.

To install the upgrade from a download package unzipped into a local or shared folder:
1 Shut down Sage 100 Contractor and all open programs except for firewall and antivirus programs.

2 Browse to the drive and folder where you extracted the upgrade files in the steps above.

3 Before you proceed further with installation, we recommend that you double-click ReleaseNotesv17.pdf to open it in
your PDF viewer. It’s a good idea to review the Release Notes for information about “Enhancements,” “Fixes,” and
“Known issues and Comments” that might apply to your network configuration and/or operating systems and affect your
upgrade installation.

4 Double-click Setup.exe to begin the installation.

a If you are running theWindows XP operating system and you get amessage advising you that the program publisher
cannot be identified, click [Run].

b If you get amessage asking if you want to allow the following program tomake changes to this computer, click [Yes].

5 On the welcomewindow, notice that a previous installation has been found, and click [Next].

6 On the installation option window, select an option, and click [Next]:

a This computer will be my Sage license server

b This computer will run Sage 100 Contractor only

7 On license agreement window, read the license agreement carefully.

8 Select the check box to accept the terms, and then click [Next].

9 On the select additional options window:
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a The installation process automatically selects the option to install the Sample Company. We recommend that you
install the Sample Company, which is used extensively in Sage 100 Contractor training classes.

IMPORTANT: The upgrade installation overwrites the existing Sample Company. If you want to save changes to the
existing Sample Company, clear the check box. If you do not overwrite the Sample Company, youmust rebuild the
indexes in the Sample Company database using 7-4 Rebuild Indexes after the upgrade installation. If you havemade
changes in your Sample Company that you wish to keep, rename this folder before installing a fresh copy of the
Sample Company.

b (If available) Update reports and report forms on a local or network drive. This does not install the entire program to the
other drive; it only updates the system reports and report forms. This only needs to be done from one workstation.

10 Click [Next]. The installation proceeds.

11 On the Installation complete window, click [Finish] to launch Sage 100 Contractor.

12 Repeat steps to upgrade all other computers running Sage 100 Contractor.

13 Follow the instructions for post-installation tasks to rebuild the indexes your company database from one computer and
reschedule your reports, as necessary.

Uninstalling Sage 100 Contractor from a Sage license server
When Sage 100 Contractor is uninstalled from an active license server, the server’s licenses are deauthorized andmade
available to be acquired by another license server.

If uninstalling and then reinstalling to a Sage license server, the licenses need to be reactivated after reinstallation.

Chapter 4: Sage ACT! Plug-in Installation
Pre-installation information
In order for Sage 100 Contractor to integrate with Sage ACT!, the following requirements must bemet:

n Sage 100 Contractor 2013 Version 18.1 or later must be installed

n Sage ACT! Premium or Sage ACT! PRO (version 2011 or later) must be installed

n Sage ACT! plug-in license usemust be obtained

Duration of the installation process
Plan on at least five to tenminutes per computer to install the Sage ACT! plug-in. The duration of the Sage 100 Contractor
installation depends a great deal upon each computer’s configuration. Installation to older computers may takemore time.

Additional required software
Sage ACT! Premium or Sage ACT! PRO (version 2011 or later) must be installed on all computers running Sage 100
Contractor software that use the Sage ACT! plug-in.

Plan for an additional 10 to 15minutes per computer to install Sage ACT! Premium or Sage ACT! PRO.

NOTE: It is very important that you understand the network environments and operating systems on the computers
and server computers where you install Sage 100 Contractor software. Chapter 6 Special Configurations provides
detailed information about installing to different environments.
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Installing the Sage ACT! plug-in
Basic steps for installation are:
1 Verify Sage 100 Contractor and Sage ACT! Premium or Sage ACT! Pro (version 2011 and later) are already installed.

2 Activate your Sage ACT! plug-in license.

3 Install the Sage ACT! plug-in on any client workstations where you use Sage ACT!.

Installation of Sage 100 Contractor and Sage ACT!

To install Sage 100 Contractor, refer to Chapter 3: Sage 100 Contractor Installation

To install Sage ACT!, refer to the installation instructions that camewith Sage ACT! Premium or Sage ACT! PRO (version
2011 or later) and see the Sage ACT! Getting Started Resource Center at http://na.sage.com/Sage-ACT/support/Getting-
Started.

Activate your Sage ACT! plug-in license use

To activate your Sage ACT! plug-in license, refer to Chapter 5: Managing Your License with License Administration in this
document.

To install the Sage ACT! plug-in on client workstations:
1 Close all open programs except for firewall and antivirus programs.

2 Browse to the drive containing Sage 100 Contractor and go to the MB7\Programs\Plug-ins folder.

3 Double-click on the ACTPluginSetup.exe to begin the installation.

4 On the welcomewindow, click [Next].

5 On the Installation complete window, click [Finish].

6 Restart computer as necessary.

http://na.sage.com/Sage-ACT/support/Getting-Started
http://na.sage.com/Sage-ACT/support/Getting-Started
http://na.sage.com/Sage-ACT/support/Getting-Started
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Chapter 5: Managing Your License with
License Administration
License Administration
When you purchase Sage 100 Contractor software, it includes the License Administration program. Using the License
Administration program, you can activate licenses andmonitor the license uses. During software installation, the License
Administration program is automatically installed on the computer that the software installer designates as the Sage license
server.

IMPORTANT: Before you can use Sage 100 Contractor with your activated license, you have to specify the
computer on your network that is the Sage license server when you launch Sage 100 Contractor.

Where is the Sage license server located?

The Sage license server is software running on a computer on your network that manages the Sage 100 Contractor
products and features that you purchased. Products and features can be a “core product,” additional “modules,” and a
number of “license uses.” The computers running your Sage 100 Contractor have to be connected to the computer running
the Sage license server so that the correct products, features, and number of license uses are available to you.

License Administration window
Use this window to view andmaintain your licensing information. This includes the number of license uses, the users who
are logged on to Sage 100 Contractor, and licensing events.

Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you
access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license
server automatically updates this information in your system. You can also select to update the licensing information from
Sage on demand.

NOTE: Licenses are granted to the specific computer where the licenses were initially activated. If you need tomove
your Sage 100 Contractor server to a different server, youmust first deactivate the licenses on the old server before
you can activate them on a new server.
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Items in this window
Item Notes

Sage client ID
Your client ID with Sage. Sage provides this information to you.

NOTE: This informationmust match the information stored on the Sage license server exactly for
the license activation to be successful.

Registration
name

The name under which your company is registered with Sage. Sage provides this information to you.

NOTE: This informationmust match the information stored on the Sage license server exactly for
the license activation to be successful.

Edit reg-
istration info

Click to edit your Sage client ID or registration name.

NOTE: This informationmust match the information stored on the Sage license server exactly for
the license activation to be successful.

Tabs in this window
Item Notes

License
information

This tab lists information about your license, such as the number of uses you have purchased, the
expiration date of your support plan, and the date and time when the last update occurred. It also
displays themodules that are licensed for your company's use of the software. You can also allo-
cate licenses acrossmultiple servers here.

Active
users This tab displays a list of users who are currently logged on to Sage 100 Contractor.

Event log This tab stores information about licensing events and indicateswhether the activationswere suc-
cessful.

About managing licenses
Use the License Administration window to activate licenses andmonitor license uses.

Activating licenses
In order to use Sage 100 Contractor, you have to activate your product licenses.

To activate your license:
1 On the License Administration window, click theEdit registration info link.

2 Enter yourSage client ID.

3 Enter yourRegistration name.

4 Click [OK].

License Information tab
The tab, which is available from the License Administration window, displays information about your Sage 100 Contractor
licenses.
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Items on this tab
Item Notes

Support plan expi-
ration date The date on which your support plan with Sage Customer Support expires.

Number of
requests which
exceeded use
count (last 90
days)

Displays the number of times the request for licenses failed in the past threemonths
because there were not enough licenses available. If there are a significant number of
requests, youmaywant to acquire additional licenses.

Last license infor-
mation update

The last date upon which your licenses were verified with Sage's license server.

NOTE: If your system cannot connect to Sage for a period of more than 10 days, you will receive
amessage indicating there is a connection problem. See Troubleshooting license activation
issues for more information.

Licensedmod-
ules

Displays a list of licenses available to this server, based on the products you have purchased from
Sage. When you purchase new products, the licenses for those products become available to
activate here. "Core" refers to the basic program, exclusive of the additional modules. Additional
module licenses that are not part of Core:

Inventory

Service Receivables

Estimating

Document Control

Equipment Management

There is also a column that shows how many Core licenses are checked out from this license server
to local machines.

Update license
information

Click to update the license informationmanually. This connects your server to the Sage license
server, where your current license information is stored, and it updates the information on this
window. This also creates entries in the event log. View the event log tomonitor the success of your
license activations.

NOTE: If you are usingmulti-server license administration, ensure you have the proper
allocations set underMulti-server licensing before you update your license information.

Deauthorize
license server

Typically, this would be used if you aremoving Sage 100 Contractor's license server from one
machine to another machine.

IMPORTANT: You need to deauthorize the old server before you authorize Sage 100
Contractor's license server on a new server.

Multi-server
licensing

This allows you to allocate your Sage licenses tomultiple servers. For example, this could
happen if you have several corporate offices and want to use separate licenses for each
office or if you want to reserve a certain quantity of license uses for a specific group of
people.
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Active Users tab
This tab of the License Administration window lists the names of all users and computers currently using Sage 100
Contractor.

Each row in the list represents a separate license use. If you find you are running out of licenses, you can review this list to
determine if any licenses can bemade available. Tomake a license available, simply close Sage 100 Contractor on one of
the computers where the program is running.

You can restrict all users from logging on to the Sage 100 Contractor software from this tab.

Items on this tab
Item Notes

User The name of the user who is currently logged on to Sage 100 Contractor.

Computer The computer where the user is logged on to Sage 100 Contractor.

Session TheWindows session for the user.

Restrict
logon/Allow
logon

Click Restrict logon to prevent users from logging on to Sage 100 Contractor temporarily. This prevents
new users from logging on to Sage 100 Contractor but does not remove existing users. Youmight use this
feature in preparation for backing up your database, for example.

If you have previously restricted logon, click Allow logon to allow users to log on to Sage 100 Contractor.

Event log tab
Use this tab of the License Administration window to view events related to licensing. This lists whether license validation
was successful or if there were any problems attempting to validate the licenses. See Troubleshooting license activation
issues for more information about issues validating licenses.

Items on this tab
Item Notes

Level The level of the licensing event (for example, informational).

Date and
time The date and time that the licensing event occurred.

Description
The description of the licensing event. Typically, this displays "License information updated," but
this will also indicate if there was a problem updating the licenses. The section below this area pro-
vides additional details about the issue.

Clear
event log Click to remove all entries in the list.
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Maintaining License Information
Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you
access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license
server automatically updates this information in your system. You can also select to update the licensing information
manually.

NOTE: Licenses are granted to the specific computer where the licenses were initially activated. If you need tomove
your Sage 100 Contractor server to a different server, youmust first deactivate the licenses on the old server before
you can activate them on a new server.

To view or change license information:

1. Select License Administration program.

2. You can view or change the information here, or you can click Update license information to retrieve current
licensing information from Sage. Note that theSage client ID andRegistration namemust match Sage's records
exactly in order for the update to be successful. To change the Sage client ID or the registration name, select Edit
registration information.

NOTE: If you havemultiple servers serving your Sage 100 Contractor application, click Multi-Server License
Administration to allocate and update your licenses.

3. To view which users are logged on to Sage 100 Contractor, click theActive users tab.

4. To view the results of the previous update attempts, click Event log. Click Clear event log if you no longer need
the information.

TIP: Formore information, click while viewing the window.

Multi-Server License Administration window
Formost users of Sage 100 Contractor, it is not necessary to allocate license across multiple servers.

This allows you to allocate your Sage licenses tomultiple servers. For example, this could happen if you have several
corporate offices and want to use separate licenses for each office or if you want to reserve a certain quantity of licenses for
a specific group of people.

Because the Core license controls the amount of license uses, it is the only license which is “use-counted.” Therefore the
only license that is allocated amongmultiple servers is the Core license.

Example 1 - Multiple servers with specific allocations

Assume you have three servers that you want to allocate as follows:
Server Licenses

Server A 3 Core licenses

Server B 3 Core licenses

Server C 4 Core licenses

At each of the servers, you would select theManually specify allocations for this server option in theMulti-Server
License Administration window, and select the number of licenses for that server.

If you later purchase additional Core licenses, youmust go into each server where you want the additional licenses to be
allocated and update the allocation.
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Example 2 - Multiple servers with specific allocations for all but one server

Assume you have three servers that you want to allocate as follows:
Server Licenses

Server A 3 Core licenses

Server B 3 Core licenses

Server C All remaining licenses

At servers A and B, select theManually specify allocations for this server option in theMulti-Server License
Administration window, and select the number of licenses for each server.

At server C, select theAllocate all available licenses to this server option in theMulti-Server License Administration
window.

NOTE: In this example, it is important to select the option for server C last. If you select to automatically allocate all
available licenses on server C first, it will take all the available licenses and there will be none left to allocate to
servers A and B.

If you purchase additional licenses, they will automatically be allocated to server C when the license activations are
updated, unless youmanually select the licenses to go to server A or B first.

Items on this window
Item Notes

Allocate all available
licenses to this server
(default)

If you choose this option, all licenses are allocated to this server. This is themost
common scenario. Do not choose this option if you want to allocate licenses across
multiple servers.

Manually specify license
allocations for this server
in the "Uses for [server
name] column below

Select this option to allocate licenses acrossmultiple servers. The amount of
licenses you select in theUses for [server name] column is the amount of licenses
allocated to this server.

Module name

Displays a list of licenses available to this server. This is based on the products you have
purchased from Sage. When you purchase new products, the licenses for those products
become available to activate here. "Core" refers to the basic program, exclusive of the
additional modules. Additional module licenses that are not part of Core:

Inventory

Service Receivables

Estimating

Document Control

Equipment Management

There is also a column that shows how many Core licenses are checked out from this
license server to local machines.

Total uses The total number of uses that are available. This displays the total number of
licenses you have purchased.
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Item Notes

Available uses

The number of uses available to this server. If some licenses have already been allo-
cated to a different server, it reduces the number of uses available here. For example,
if you have 10 total uses, and 2 have been allocated to another server, the available
uses for this server is 8.

Uses for [server
name]

The number of uses allocated to this server. You can change the number here, but you can only
add uses if there are still uses available. You can decrease uses tomakemore licenses
available to other servers.

If you need to havemore uses available to this server, youmust first relinquish licenses on one
of your other servers, or purchase additional licenses.

[OK] Click to allocate the licenses selected in theUses for [server name] column to this server.

[Cancel] Click to cancel this window without making any changes.

To open this window, open the License Administration program and on the License Information tab, click [Multi-server
licensing].
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Managing Licenses

Checking out and checking in a license use
You can use Sage 100 Contractor when your computer cannot actively communicate with the license server, by checking
out a license use from the Sage license server.

NOTE: Checking out a product license use removes it from the license server's pool of generally available license
uses and places it directly on the computer checking out the license. However, this may prevent other user access to
Sage 100 Contractor, so checking out a license should only be used when necessary.

To check out a license use:
1 From the Sage 100 Contractor main window, on the Filemenu, click Check Out License Use.

2 Click Yes.

IMPORTANT: A checked out product license use remains on this computer until you use the related option Check
In License Use from the File menu.

To check in a license use:
1 From the Sage 100 Contractor main window, on the Filemenu, click Check In License Use.

2 Click Yes.

Administering a different license server
In the License Administration program, you can see the number of license uses, the users who are logged on to Sage 100
Contractor, and licensing events for this license server.

Licenses are granted to the specific computer where the licenses were initially activated. If you need to see the license
uses available on another Sage license server, you can do that in the License Administration window.

To administer a different license server:
1 Select the License Administration program.

2 From the License Administration window, click Administer Different Server.

3 Enter computer name or IP address. How?

Troubleshooting License Issues

Troubleshooting license activation issues
Your system will automatically retrieve license information from Sage daily. The licenses give you access to the various
modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license activation server
automatically updates this information in your system.

If the server that hosts Sage 100 Contractor is unable to connect to the Sage license server for more than 10 days, you will
receive amessage indicating there is a connection problem. The following are some of themore common issues that can
cause this to occur.

There is a problem with your Internet connection.

The Sage 100 Contractor server connects to the Sage license server through the Internet. Check tomake sure the server's
connection to the Internet is intact.
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There is a problem with your network.

Any network issues that interrupt the Internet connection (such as firewall settings) can prevent the Sage 100 Contractor
server from connecting to the Sage license server. Confirm that your firewall is configured correctly and that all network
components are operating properly.

The registration information does not match.

TheSage client ID andRegistration Name on the License Administration window must match the information on the
Sage license server. Ensure the information is entered correctly here.

You have exceeded your license activations.

You do not have enough licenses to support everyone attempting to use Sage 100 Contractor. Youmay want to purchase
more licenses.

TIP: TheNumber of requests which exceeded use count box on the License information tab of the License
Administration window displays the number of times in the last threemonths that requests for licenses have exceeded
the number of licenses available.

About the Sage 100 Contractor license use status
You can view the current state of your Sage license use in the About Sage 100 Contractor window. Your license use status
is defined by several factors involving your network connectivity and the availability of license uses. The following table
presents license use status definitions:

About Sage 100
Contractor window

displays
License use status definition

License use not
acquired

You don’t have a license use. (You haven’t logged into a company database yet, or
requesting a use at login failed to retrieve one.)

License use acquired
from server Normal operating condition when you're logged into a company.

License use returned
to server

You’re at themainmenu and logged out of the company database after having
acquired a license use previously.

License use lost from
server

You’re previously acquired license use has been taken back by the license server
because you’ve lost communication. You’re in the “restricted” condition.

License use is
checked out

Equivalent to “License use acquired from server” except that you’re using a checked
out license.

Connection not estab-
lished

There’s a communication error and themachine can’t talk to the license server. (The
server isn’t available, the licensing service isn’t running on the server, or it’s not open on
the designated port.)

NOTE: If the computer running the Sage license server becomes disconnected from the other computers on your
network, or if your computer becomes disconnected from the Sage license server, youmay see an alert message
from Sage 100 Contractor telling you that you are disconnected.
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Viewing the Sage license use status
You can view the current Sage license use status. This may help you in situations where your Sage license use status is
not what you expect it to be. Viewing the status can help you troubleshoot problems.

To view the Sage license use status:
1 From the Sage 100 Contractor main window, click [Help > About Sage 100 Contractor].

2 The About Sage 100 Contractor window appears.

3 In the lower right of the window, look for Sage license use status.

4 The text displays the current license use state:

a License use not acquired

b License use acquired from server

c License use returned to server

d License use lost from server

e License use is checked out

f Connection not established
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Chapter 6: License Use and Sage 100
Contractor
Specify Sage License Server
Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on your network
that is the Sage license server. There are two ways to specify the Sage license server:

o You can select the computer from the list of computers on your network; or

o You can enter the IP Address or name of the computer.

Selecting the Sage license server computer
Onemethod is to select the computer running the Sage license server from the list of network computers.

NOTE: To use this method of selecting a server from the list of network computers, youmust have already clicked
the appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network computers:
1 On the Select License Server window from the list of network computers, select the computer running the Sage license
server.

2 Click [OK].

Entering the IP Address or name of the computer
Onemethod is to enter the IP Address or name of the computer running the Sage license server.

NOTE: To use this method of selecting a server from the list of network computers, you have already clicked the
appropriate link on the Specify Sage License Server window.

To enter the IP Address or name of the computer running the Sage license server:
1 In the text box, type the IP Address or name of the computer.

2 Click [OK].

Determining the name of a computer

NOTE: If you are trying to determine the name of the computer running the Sage license server, youmust complete
this procedure on that computer.

To determine the name of a computer:
1 Click Start > Settings > Control Panel.

2 From the list, scroll to and double-click System.
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3 The System Properties window appears.

4 Locate the line Full computer name, and write it down or type it into a note that you can print.

5 Click [Cancel].

Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server, youmust complete
this procedure on that computer.

To determine the IP Address of a computer:
1 Click Start > Run.

2 In the Open text box, type cmd, then click [OK].

3 The \Windows\...\cmd.exe window appears.

4 At the prompt, type ipconfig.

5 For example, youmight see H:\. Type ipconfig after the drive letter. When you press the Enter key, the system displays
several addresses, among which is the IP Address of the computer. You see a line similar to this:

IP Address . . . . . . . .172.20.22.142

What is an IP Address?
Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP) address. This
numeric address of a computer on the Internet is written as a set of four numbers separated by periods (each number can
range from 0 to 255). An example of an IP Address is 123.123.4.5.

NOTE: If you are trying to determine the IP Address of the computer running the Sage license server, youmust
complete the procedure on that computer.

What is a server?
There aremany kinds of servers. Some servers are denoted by their hardware configuration and a specialized operating
system. Other servers consist of specialized software applications running on standard computers.

Some servers are called “file servers” andmay be a powerful computer dedicated to storing files and data. For example,
Sage 100 Contractor company data can be stored on a file server. Any Sage 100 Contractor user on the same network as
the file server can access and store data there.

A server can also be a software application that provides a specific kind of service to client software running on other
computers. The term server can refer to a particular piece of software, such as the Sage license server. When we refer to
the Sage license server, we are describing a computer that is running the Sage license server software.
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Chapter 7: Special Configurations -
Operating Systems and Services
Windows 7 Professional and Server 2008 R2 Standard Operating
Systems

Launching Sage 100 Contractor to run as administrator for scheduling reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100
Contractor reports requires that you “Run as administrator” or to “Run this program as an administrator.”

Microsoft Windows has changed security rules in theWindows 7 Professional and Server 2008 R2 Standard operating
systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, youmust
launch Sage 100 Contractor with the command to eitherRun as administrator orRun this program as an
administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as
administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your
settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you
run the program as administrator for that session only. When you select Run this program as an administrator, you set
program properties to always run the program as administrator when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related toWindows 7
Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are
running.

To set "Run as administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, to launch the program, click [Run as administrator].

NOTE: SelectingRun as administrator only runs the current session of running Sage 100 Contractor. The setting
does not persist after the session is over.

To set "Run this program as an administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, click [Properties].

3 On the Sage 100 Contractor Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].
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NOTE: SelectingRun this program as an administrator always runs the program with these properties when you
launch the program on this computer. The setting persists.

Windows 7 Professional and Server 2008 R2 Standard "Sleep Mode" prevents
computers from obtaining a license use
If a computer running theWindows 7 Professional or Server 2008 R2 Standard operating system is used as a license
server, when it goes into sleepmode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never:”

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 7 Professional and Server 2008 R2 Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 7 Professional or Server 2008 R2 Standard operating systems. If the service stops, the program displays a
message advising you to take further action to resolve this issue.

Solution for Server 2008 R2 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2008 R2, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2008 R2 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2008 R2 operating systemmust
be enabled. To enable file sharing, follow the instructions in theWindows Server 2008 R2Help.

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows Server 2008 R2
machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it
automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the followingmessage during the
licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you click [OK], the installation
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continues, but the services have not been installed so Sage 100 Contractor cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above
message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:
1 Click theStart button in the lower left corner of the display.

2 Highlight Administrative Tools and select Server Manager.

3 In theServer Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that
.NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:
1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click [Install].

5 Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.

Windows Vista and Server 2008 Operating Systems

Installation and AutoPlay
Program installations begin immediately upon inserting the CD into the CD-ROM drive if AutoPlay is set to begin
automatically. With computers running theWindows XP operating system, you can start the installationmanually by using
theStart > Run > Browse command to locate and select setup.exe. With computers running the Vista and Server 2008
operating systems, this command path has changed.

o OnVista/Windows 7, click the Vista/Windows 7 button (left circular button at lower left of the system tray) to open a
window with the Start/Search text box at the bottom. Type setup.exe in the text box, and press the Enter key. When
the system search locates the file on the CD, double-click the file to begin the installation process.

o OnServer 2008, click Start > Run > Browse. Locate setup.exe, on the CD, and double-click the file to start the
installation.

Launching Sage 100 Contractor to run as administrator for scheduling reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100
Contractor reports requires that you “Run as administrator” or to “Run this program as an administrator.”

Microsoft Windows has changed security rules in theWindows 7 Professional and Server 2008 R2 Standard operating
systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, youmust
launch Sage 100 Contractor with the command to eitherRun as administrator orRun this program as an
administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as
administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your
settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you
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run the program as administrator for that session only. When you select Run this program as an administrator, you set
program properties to always run the program as administrator when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related toWindows 7
Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are
running.

To set "Run as administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, to launch the program, click [Run as administrator].

NOTE: SelectingRun as administrator only runs the current session of running Sage 100 Contractor. The setting
does not persist after the session is over.

To set "Run this program as an administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, click [Properties].

3 On the Sage 100 Contractor Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].

NOTE: SelectingRun this program as an administrator always runs the program with these properties when you
launch the program on this computer. The setting persists.

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the workstations
cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in
place of Vista or Server 2008, for example, Windows XP.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to Never:
1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.

3 From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Vista, Windows 7, or Server 2008

IMPORTANT: Read this information if you are running Vista or Server 2008 operating systems on your office
computers.

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Vista,
Windows 7, or Server 2008 operating systems. If the service stops, the program displays amessage advising you to take
further action to resolve this issue.
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Solution for Server 2008 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2008, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click the [Security] tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Vista, Windows 7, and Server 2008, or Server 2008 R2 installation and mapped
drives
Mapped drives may not be available when installing on a computer running the Vista, Windows 7, or Server 2008 operating
systems. See theMicrosoft knowledgebase article about allowingmapped drives to display elevated users:
http://support.microsoft.com/kb/937624/

NOTE: If you need to install to amapped drive, install the program to a computer that is running another supported
operating system, such as Windows XP.

Vista, Windows 7, and Server 2008 network configuration and TCP Remoting
Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File sharing on computers running the Vista, Windows 7, or Server 2008 operating system
must be enabled. To enable file sharing, follow the instructions in the Vista, Windows 7, or Server 2008 Help.

Vista, Windows 7, and Server 2008 and changing the Sage License Server
computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the commandmay fail to generate a list of network computer
names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the
server computer in the box.

http://support.microsoft.com/kb/937624/


- 43 -

Windows Server 2003 Operating System
NOTE: Configuration forWindows Small Business Server 2003 is the same as configuration forWindows Server
2003.

Configuring Windows Server 2003 date format
It is necessary when usingWindows Server 2003 to configure the date format.

To configure the Windows Server 2003 date format:
1 Click the [Start] button, point toControl Panel, then click Regional and Language Options.

2 On theRegional and Language Options dialog box, on theRegional Options tab, click theCustomize... button.

3 On theCustomize Regional Options dialog box, click the [Date] tab.

4 UnderShort date, from theShort date format drop-down list, selectMM/dd/yyyy.

5 Click [OK].

6 To closeCustomize Regional Options, click [OK] again.

Setting up Windows Server 2003 for PDF and RTF printers
InWindows Server 2003 (Standard Edition) andWindows Server 2003 (Enterprise Edition), the installation of kernel-mode
drivers is blocked by default. Before you can install Sage 100 Contractor PDF and RTF printers withWindows 2003 Server,
you have to unblock the installation of the kernel-mode drivers and edit the Group Policy.

To unblock the installation and edit the Group Policy:
1 On yourWindows Server desktop, click [Start], thenRun....

2 TheRun dialog box opens.

3 In theOpen: text box, type gpedit.msc, and then press Enter.

4 TheGroup Policywindow opens.

5 In the left pane, on the Tree tab, double-click theAdministrative Templates folder.

6 Then double-click thePrinters folder.

7 In the right pane, in theSetting list, find and set the state of the setting forDisallow installation of printers using
kernel-mode drivers toDisable.

Windows XP Professional (SP2) Operating System

Configuring the Windows XP Professional date format
To configure the date format:
1 Click the [Start] button, point toSettings, and click Control Panel.

2 Double-click theRegional and Language Options icon, and click theRegional Options tab.

3 Click theCustomize button and theDate tab.

4 In theShort Date Format list, selectMM/dd/yyyy.

5 Click [OK].
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Citrix and Terminal Servers

Using Citrix and Terminal Server with Sage 100 Contractor
Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If Sage 100
Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, then youmay log on to the
computer running Citrix or Terminal Server with your laptop and work in Sage 100 Contractor on your LAN. This enables
you to work from home, from a job site, or from any number of other remote locations.

We recommend that you use DOS commands to change the operatingmode from “execute” to “install” and then back to
“execute.”When using the DOS commands to install, youmay install the Sage 100 Contractor software as you would on
any desktop orWindows server operating system that meets Sage 100 Contractor requirements.

Installing on computers running Citrix and Terminal Server using DOS commands
To install using DOS commands:

1 Click [Start], thenRun.

2 On theRunwindow, in theOpen drop-down box, type cmd, and press the Enter key.

3 The \Windows\...\cmd.exewindow appears.

4 At the prompt, type change user /install, and press the Enter key.

5 This enables the install mode.

6 Install the Sage 100 Contractor software as you would on a typical workstation orWindows Server.

7 At the end of the installation process, choose to launch the License Administration Tool.

8 Using the License Administration Tool window, manage your license and activate it.

9 After activation, click [Start], then [Run].

10 On theRunwindow, in theOpen drop-down box, type cmd, and press the Enter key.

11 The \Windows\...\cmd.exewindow appears.

12 At the prompt, type change user /execute.

13 This enables the executemode, which is the default mode for running Citrix and Terminal Server.

14 Exit theRunwindow.

15 Restart the server.

IMPORTANT: If this message appears: “Install mode does not apply to a terminal server configured for remote
administration,” then it is not necessary to enable the install mode. Youmay install the Sage 100 Contractor software
as you would on a typical workstation.
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Backing Up Your Data
With any computer system, there is the possibility for failure and loss of data.

Caution!

Use a backupmethod and device suitable for your business requirements. We strongly recommend that youmaintain a
routine backup schedule and store your data in a safe environment that is separate from your server, preferably off site.

Which files to back up in Sage 100 Contractor

NOTE: This topic only applies to existing Sage 100 Contractor customers.

When you back up your company data, we recommend that you back up your company financial data as well as all your
custom reports and forms. If you are runningmultiple Sage 100 Contractor companies, back all of them up.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company.

To see the number of files and folder in a company folder, inWindows Explorer, right-click the company folder and select
Properties. On the Properties window, the General tab, look in the list for the Contains line for the number of files and
folders. Write this number down so that you can refer to it after you havemade the two copies. The number of files and
folders has to be exactly the same in both the company and the backup copy.

IMPORTANT: If you are working across a network, youmust remember to backup company folders, report folders,
and form folders that reside at the server.

We strongly recommend that you back up:

o Each company folder that contains financial data (\MB7\your company\)

o TheCustom Reports folder (\MB7\Custom Reports)

o TheReport Forms folder (\MB7\Report Forms)
o TheSystem Reports folder (\MB7\System Reports)

IMPORTANT: When backing up your data, be sure tomake a full backup and not an incremental or differential
backup. An incremental or differential backup only records alterations to the data since the last backup.

An example of one backup method
There are various methods for backing up your data. Depending on the amount of data entry you routinely perform, you
might consider making full daily backups. It is also a good idea to regularly take one backup off the business premises or
store them in a fireproof safe. If a burglary or fire occurs, a copy of your data is safe from harm.

One reliable procedure, requiring a tape drive andmultiple sets of tapes, requires you tomake daily andmonthly backups.

Daily Backup Process

For the daily backup process, you need 10 tapes. Label five of the tapes as Week A, with a tape designated for each
weekday. Label the other five tapes as Week B, with a tape designated for each weekday.

Start with the set of tapes labeledWeek A. Monday night when youmake the backup use the tape labeledMonday, on
Tuesday use the tape labeled Tuesday, and so forth. At the start of the next week, use the set of tapes labeledWeek B to
make your backups. At the end of two weeks, you will have a data backup for each day. Then at the start of the third week,
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use the set of tapes labeledWeek A again. Over the course of a year, you will cycle through the two sets of tapes. Be sure
to store themost recent Friday backup off site.

Monthly Backup Process

For themonthly backups, you need a separate set of three tapes labeledMonth A, Month B, andMonth C respectively. Like
the weekly backups, use each tape to back up the data for a different month, cycling through each of the tapes over the
course of the year. After making amonthly backup, write themonth and year on the label to help you track which tape to
use next. Be sure to remove themost recent monthly backup off site.

Backing up your data to a CD or DVD
This topic suggests a generic way to back up your data to a CD or DVD. Backing up to a CD or DVD successfully depends
on your computer system, including hardware and software. To back up to a CD or DVD, youmust have access to a CD or
DVD (Read/ Write capability), and the appropriate CD or DVD media.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company. To see the number of files and folder in a company folder, inWindows Explorer, right-click the company folder
and select Properties. On the Properties window, the General tab, look in the list for the Contains line for the number of files
and folders. Write this number down so that you can refer to it after you havemade the two copies. The number of files and
folders have to be exactly the same in both the company and the backup copy.

IMPORTANT: If you are working across a network, youmust remember to backup company folders, report folders,
and form folders that reside at the server.

To back up your data to a CD or DVD:
1 Place the CD or DVD media in the CD or DVD.

2 On yourWindows desktop, right-click [Start > Explore].

3 InWindows Explorer, locate the \MB7\ folder again, right-click the [Custom Reports] folder and from themenu select
[Copy].

4 Locate the CD or DVD drive, and click it.

5 Then in the right-pane, right-click and select [Paste].

6 InWindows Explorer, locate the \MB7\ folder again, right-click the [Report Forms] folder and from themenu select
[Copy].

7 Locate the CD or DVD drive, and click it.

8 Then in the right-pane, right-click and select [Paste].

9 InWindows Explorer, locate the \MB7\ folder again, right-click the [System Reports] folder and from themenu select
[Copy].

10 Locate the CD or DVD drive, and click it.

11 Then in the right-pane, right-click and select [Paste].

12 InWindows Explorer, locate the \MB7 folder.

13 Right-click a company folder that contains current financial data, and from themenu, select [Copy].

14 Locate the CD or DVD drive, and click it.

15 Then in the right-pane, right-click and select [Paste].

16 Repeat 12 through 15 for every active company with current financial data.
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Depending on your hardware and software, the folder will be copied to the CD or DVD media. For further information or
support, contact your CD or DVD manufacturer.
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